# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logging into Provide® Enterprise</td>
<td>5</td>
</tr>
<tr>
<td>Request Password Reset</td>
<td>7</td>
</tr>
<tr>
<td>Status Bar</td>
<td>8</td>
</tr>
<tr>
<td>Windows Toolbar</td>
<td>8</td>
</tr>
<tr>
<td>File Menu</td>
<td>9</td>
</tr>
<tr>
<td>Change Password</td>
<td>9</td>
</tr>
<tr>
<td>Setting Your Security Question</td>
<td>10</td>
</tr>
<tr>
<td>Lock</td>
<td>10</td>
</tr>
<tr>
<td>Print</td>
<td>11</td>
</tr>
<tr>
<td>Exit</td>
<td>11</td>
</tr>
<tr>
<td>Find Menu</td>
<td>12</td>
</tr>
<tr>
<td>Find Client</td>
<td>12</td>
</tr>
<tr>
<td>View Menu</td>
<td>13</td>
</tr>
<tr>
<td>Changing/Sorting Views</td>
<td>13</td>
</tr>
<tr>
<td>Filtering Views</td>
<td>15</td>
</tr>
<tr>
<td>Adjusting Tab Sizes</td>
<td>15</td>
</tr>
<tr>
<td>Type Ahead in Views</td>
<td>16</td>
</tr>
<tr>
<td>Actions Menu</td>
<td>16</td>
</tr>
<tr>
<td>Register Client</td>
<td>16</td>
</tr>
<tr>
<td>Tools Menu</td>
<td>17</td>
</tr>
<tr>
<td>Set-Security</td>
<td>17</td>
</tr>
<tr>
<td>Current Profile</td>
<td>17</td>
</tr>
<tr>
<td>Current Reporting Scope</td>
<td>18</td>
</tr>
<tr>
<td>View Effective Date</td>
<td>18</td>
</tr>
<tr>
<td>Preferences</td>
<td>19</td>
</tr>
<tr>
<td>Opening the User Preferences Dialog</td>
<td>19</td>
</tr>
<tr>
<td>Refresh</td>
<td>21</td>
</tr>
<tr>
<td>Reports Menu</td>
<td>22</td>
</tr>
<tr>
<td>Run</td>
<td>22</td>
</tr>
<tr>
<td>Windows Menu</td>
<td>22</td>
</tr>
<tr>
<td>Layout Selection</td>
<td>22</td>
</tr>
<tr>
<td>Cascading Windows</td>
<td>23</td>
</tr>
<tr>
<td>Vertically Tiling Windows</td>
<td>23</td>
</tr>
</tbody>
</table>
Logging into Provide® Enterprise

To launch Provide® Enterprise, you will want to double click with your mouse on the Provide® Enterprise Client Icon that has been placed on your Desktop during installation (similar to that in the figure below). The Icon is appearance is somewhat transparent.

Also, you may “Pin” the icon to you task bar by right clicking on the icon and clicking on “Pin to Taskbar.” The icon will look similar to this and be on your task bar. You can also a “Pin to Start Menu” by right clicking on the icon and clicking on “Pin to Start Menu.” It will then appear on the start menu of your computer and appears similar to.

The Login Screen will appear, similar to that in the figure below:

![Login Screen](image)

Enter the User Name, Password, Server and Database provided by your System Administrator. Click on the OK button to log into the system.
NOTE: After you have logged on for the first time, the User name, Server and Database will be automatically saved on your computer and will be populated in the login dialog box on future logins. You will only need to re-enter your password.

As Provide® Enterprise is loading you will get the following alert, reminding you that you are entering a system that is for official use only and, by accessing this system, you are consenting to the recording and monitoring of your activities.

After you click OK to this message, you will notice a window similar to the following on your screen:

As a security measure, Provide® Enterprise will automatically lock your account after three consecutive failed logins. If this happens, you will need to contact your Provide® Enterprise Administrator to reset your account or you can click on the Request Password Reset button and answer security questions to re-set your password.
Request Password Reset
After you have your security questions (see “Setting Your Security Question” section below for detailed direction on establishing your security questions) you can request a password reset when logging-in by clicking on Request Password Reset.

After clicking on Request Password Reset, your security questions will appear for you to answer.

After you answer the questions, click on OK.

After clicking OK, you will receive the message below that a password reset request has been sent your email address.
• You will then receive an email with your new password, similar to the email shown below:

![Email example](image)

**Status Bar**
An example of the Status Bar appears below. This is variable for each customer and the user’s preferences, security, and the user’s customization.

![Status Bar example](image)

**New Task Alerts:** This shows the number of new task alerts you have. If you have any new tasks, this box will be highlighted in red until you view the alerts. For instructions on how to set your Task Alert, please see the “Preferences” section of this User Guide.

**New Database Alerts:** This shows the number of new database alerts for you. This box will be highlighted red until you view the database alert. Database alerts can either be sent by VA Department of Health staff or by Groupware Technologies (GTI) to send a message to all Provide users within the database.

**User Security:** This is your current user security

**User Name:** This is your user name when logging into Provide.

**Server/Database:** This is the server and database you are currently logged into.

**Windows Toolbar**
If you do not have a Start-up Action defined when you log into Provide Enterprise for the first time, all you will see is the Windows Toolbar, similar to the following. By clicking on each of the menu choices you will have different choices for configuring, navigating or viewing information. Some of the more important menu choices will be discussed below:
File Menu
The File Menu options are outlined below.

Change Password
You can change your password in Provide® Enterprise by completing the following steps.

• From your Windows menu choose “File” and then “Change Password” as shown below.

• The following window will appear:

• Type in your current password, then type your new password two times.

• Click on the OK button. A message similar to the one in the figure below will appear:
• Next, click on the **OK** button. Your Provide® Enterprise software will automatically be closed and you will need to log back in using the new password.

**Setting Your Security Question**

To set your security questions in Provide, when you are in the system, click on File – Set Security Questions.

• Select security questions and corresponding answers. You also will need to enter your email address.

• After the information, click **OK**. You may set or re-set your security questions at any time.

**Lock**

If you wish to lock Provide® Enterprise in order to prevent anyone else from accessing your data when you are away from your computer, please follow these steps:
• From your Windows menu choose “File” and then “Lock” as shown below.

![Lock Prompt](image)

• You will notice that Provide® Enterprise will immediately be minimized.

• Click on the Provide® Enterprise Window on your Windows Taskbar (example shown above) and the following window will appear:

![Login Window](image)

• Type in your password, and then click on the “Unlock” button. You will be brought back to the same screen you were on at the time that you locked Provide® Enterprise. NOTE: Your Provide system will automatically “lock” if you are inactive in the system for

**Print**

Using the File – Print command will print the document you are viewing or the view you have open. You may also select File – Print Preview to view a preview of what has been selected to be printed before actually printing the document.

**Exit**

Using the File – Exit command will close Provide® Enterprise and take you back to your Windows Desktop.

• When you click on the File – Exit command you will see the following window appear on your screen:
• Select “Yes” to exit or “No” to continue working in Provide® Enterprise.

Find Menu
The Find Menu in Provide® Enterprise is customized for every Provide® Enterprise implementation and the list of options can be variable based on the user rights. The “Find Client” below is one example of how a “Find” sort works.

Find Client
You can bring up the Find - Client tool in Provide® Enterprise by completing the following steps.

• From your Windows menu choose “Find” and then “Client” as the following shows.

A window similar to the one below will appear:
• Type in one or more of the search fields and then click on the **Search** button. You can enter an asterisk (*) as a wild card to do more general searches. If multiple fields are entered, only those client records that match all of the values will be found.

• After the search is completed, the Client records that match the search criteria are listed and displayed below the search dialog.

• Simply double click on the record that you wish to view in order to open the desired Client Profile.

**View Menu**

The View Menu allows you to select a view of records to be displayed. Each Provide® Enterprise customer has the ability to define their own views. Any time there is a ▶ in a view, you can expand the sub categories that are defined as a part of that particular view.

Notice what happens in the example below when picking the “Activity” view. The view expands to include a further break down of the Activity category. When you click on “Appointments”, the view expands to include a further break down of the “Appointments” category. You now can see that there are three different “Appointments” views to choose from.

Click on the one that you wish to display. Once the view has opened, you can double click on any record that you wish to open.

**Changing/Sorting Views**

In Provide® Enterprise, you can change how the views are displayed to you. You can sort any views by simply dragging columns depending if you want to view columns in a specific order.

For example, if you want to display a client list by last name it would appear:

However, if you want to display your client list by first name, you would click on the first name and drag it in front of the last name column. As seen below: (notice the red arrow)

The view will then appear with the “First Name” as the first column such as:
You are also able to sort each column simply by clicking on the column:

A [image] will be displayed in the column indicating the direction of the sort. In the example above, the last name is sorted by descending alphabetical order (sort A→Z). A [image] would indicate ascending order (sort Z→A). Clicking one time will give you descending order and clicking twice will give you ascending order.

You can also change the size of your columns by simply dragging the sides of the columns.

In any view that you are attempting to search, you can also group the view by clicking on [image] on top of the page. After you click on the icon, your screen will appear like the one below. You will see the screen below and “Drag a column header here to group by that column.”

Drag the column header to the designated area to group by that view. For example, if you want to group your view by last name, you can drag the column “Last Name” into the box as seen below:
To “Un-Group” your view, drag the column out of the designated area. You can then click on the on the button again to remove the filtering column header gray box from your view. These sorting/grouping options are available in all views. When you log-off of Provide, the views will return to their default; therefore, you will need to re-sort your views.

Filtering Views

To filter a view, click on to show the filter bar. A bar will appear on top of your screen similar to the one below depending on the view you are currently viewing:

In any of the boxes, you may filter your view. For example, if you would like to view all of the appointments that are on 1/8/2018, you can simply enter “1/8/2018” in the Date box.

This will filter your view to only see appointments that are on 1/8/2018. To remove the view filter, simply delete the text you entered (in the example above, delete the “1/8/2018”). If you do not want to see the filter bar, click on to remove the filtering bar from your view.

Adjusting Tab Sizes

You can also change the size of your tabs by simply dragging the side the tab.
Once you have the tabs the size you would like, you can set the size as your default tab size by clicking on Tools – Set Default Tab Width. This will save your default tab width.

**Type Ahead in Views**
In any view that you are attempting to search, you can “Type Ahead” to help increase the speed of your searching. These filtering options are available in all views. When you log-off of Provide, the views will return to their default; therefore; you will need to re-sort your views. In the example below, if you were searching for “AIDS Healthcare Foundation – Client Services”, you could start typing “A” and the choices will start to load for you.

**Actions Menu**
There is one available action here that is used to register a new client in Provide\textsuperscript{®} Enterprise.

**Register Client**
In order to register a client in Provide\textsuperscript{®} Enterprise go to the Windows Toolbar, select “Actions” and then “Register Client”.
If your current user profile does not allow you to register clients, you will get an error message stating “Your current user profile does now allow you to register clients.”

If your current user profile does allow you to register clients, a window similar to the one below will appear on your screen:

**NOTE:** This screen will be discussed in more detail in the “Client Registration and Completing the Client Profile” User Guide.

**Tools Menu**
From the Tools Menu, you can set user preferences or refresh design elements.

**Set-Security**
Provide Enterprise allows for a variety of user preferences to be set. Click on Tools and click on User Security.

**Current Profile**
The Current Profile box allows you to select and/or change the User Profile that you wish to enter and/or view information from. To change your current profile, click on the dropdown at the top of the screen and then select the profile you want to change to.

**PLEASE NOTE:** If your user account/agency has multiple programs (Client Services, Medical Case Management, Outreach Services, or Behavioral Health Services), the “Client Services” program **must** be selected as your Current Profile. For example, in the image below, “Virgina Department of Health – Care Services” is selected as the Current Profile.
Current Reporting Scope
The Current Reporting Scope reflects the User Profiles that your System Administrator has defined for you. To select reporting scopes, click on the scope and a green check mark will placed next to the scope selection.

For example, in the image below, there is a green checkmark next to “Blue Ridge Health District – Care Services”, “Community Access Network – Care Services”, and Council of Community Services – Care Services” so this account would be able to view services and other data entered by those 3 additional agencies.

View Effective Date
The View Effective Date preference allows you to select how you want to view client information, Current records or records as of a particular date range in the past.
To change the View Effective Date, follow these steps:

- Click on the ▼ next to the View Effective Date field. Your two choices can be seen in the following figure.

- If you select “Past”, an additional field (seen in the figure below) will appear to allow you to select the date that you wish to view information from.

- Simply type in the date that you want to select.

**Preferences**

Provide® Enterprise allows for a variety of user preferences to be set.

**Opening the User Preferences Dialog**

To open the User Preferences Dialog box in Provide® Enterprise, follow the steps below: From the Windows Toolbar (in the figure below), select “Tools” and then “User Preferences”.

This will activate the User Preferences Dialog seen in the figure below:
The User Preferences Dialog Box consists of four different tabs, which will be discussed below.

**General Tab**
The General Tab of the User Preferences consists of the most basic preferences you can define in Provide® Enterprise.

- **Date Format/Date Format Example**
  In this field, you can select the format that dates are presented on your screen for both data entry and viewing.

- **User Language**
  If fields have been translated to different languages, you can change the “User Language” to view on screen field prompts in the selected language. NOTE: If a language is selected and fields have not been translated, the field will show in English.

- **Views Show Grid Lines/Alternating Colors**
  You can select to view grid lines and alternate colors rows within the Provide® Enterprise system. Select Yes or No for each of these preferences.

- **Show filter bar at open of view**
  If you select “Yes” to this, the filter bar will appear at the top of every view in Provide® Enterprise to allow you to filter on any column in the view.

- **Task Alert View**
  This is the view that Provide uses to determine if task alerts should be sent to you. Task alerts will show at the bottom of your Provide screen in Red when assigned. You can select your Task Alerts View by clicking the square button to the right of this field to find and select the view that you wish to use to notify you.

- **Task Alert View to Open**
  This view will open when you click on the new alert that will be highlighted the color red in your status bar. You can select your Task Alerts View to Open.
• **Default Attachment Type**
  You can select the type of attachment that will default when entering scanned documents/attachments. “File” attachments would include any type of file, including PDF files, text files, Excel files, Word documents, etc. Image attachments would be either a jpg or a tiff file.

• **Provider**
  The provider listed in this field will show as the default Provider when you enter any activity record in Provide.

**Common Tab**
This tab allows you to define some of the values that will default when entering data in various activity records throughout the system. You can define a common list of Diagnosis, Procedures, Providers, Facilities, Service Organizations Drugs and Tests. To start a list, simply click the square button to the right of the field. You will be able to then search for specific values, or select the values from a view.

**Other Tab**
The Other Tab of the User Preferences allows you to define some additional values that will be assigned to your preferences throughout Provide® Enterprise.

• **Soft Deletes**: This field allows you to specify whether or not you want to see deleted records when reviewing a Client Chart.

• **Startup Action**: This field allows you to define what happens automatically when you launch the Provide® Enterprise Client.

**Refresh**
Provide® Enterprise allows you to refresh certain design elements without having to log out of the application.

If the System Administrator has made changes to your Data Dictionary, Keywords, Program Profiles, Reports or available Views while you have been logged into Provide® Enterprise, you can update them instantly by clicking on the Tools - Refresh menu.

After you have made a selection you will see the spinning blue circle icon while the design element is updating. Each time you log into Provide® Enterprise these design elements are automatically updated for you.
Reports Menu
From the Reports Menu you can either run a report or manage your report objects. Each of these items is discussed below.

Run
Using the “Run” selection will allow you to run any “Stand Alone” reports that have been added to your system. To do this, follow these steps:

- Select the Reports - Run menu as shown below:

![Select a Report](image)

- If you have reports that are available to be run as a “Stand Alone” report, they will be displayed in a dialog box similar the one shown below. NOTE: The list of reports that you see will be different and custom to your PE deployment.

- Simply click on the Report name and then click on the “OK” button to run the report.

Windows Menu
Clicking on the Windows Menu will present a few different options for you.

Layout Selection
The “Layout Selection” choice of the Windows Menu, will allow you to select how you wish to view the open windows on your screen.
Cascading Windows
If you select “Cascade” from the Layout Selection menu, all of the windows you have open in Provide® Enterprise will be opened, one on top of each other, and you will be able to see the title of each open window at the top of that window. This can be seen in the figure below:

Switching between windows is as simple as clicking on the window you want to view.

Vertically Tiling Windows
If you select “Tile Vertical” from the Layout Selection menu, all of the windows you have open in Provide® Enterprise will appear on your screen in a vertical tiled pattern, similar to that in the figure below:

Switching between windows is as simple as clicking on the window you want to view.
**Horizontally Tiling Windows**

If you select “Tile Horizontal” from the Layout Selection menu, all of the windows you have open in Provide® Enterprise will appear on your screen in a horizontal tiled pattern, similar to that in the following figure.

![Figure of tiled windows](image)

Switching between windows is as simple as clicking on the window you want to view.

**Viewing Open Windows**

The final choice under the Windows Menu is a numbered list of all windows that are open in Provide® Enterprise. The window with the check mark by it is the active window.

![Windows menu](image)

**NOTE:** You can select any of the numbered window choices to move to a different window.

**Help Menu**

From the Help Menu you can find more information regarding the Provide® Enterprise version on your machine, direct you to the Provide® Enterprise support website, and Provide® Enterprise email support.

![Help menu](image)
• Clicking on “About” will bring up the following Window:

![About Window]

**NOTE:** You can see the current version of the Provide® Enterprise that is installed on your machine.

• Clicking on “Support Website” will bring the Provide® Enterprise website for your community and any associated help documentation.

• Clicking “Email Support” will link to your email and allow you to email the Provide® Enterprise technical support team.

**Fields**

There are several different types of fields used within the Provide® Enterprise system. They will each be described briefly below.

When a field is editable, the text is bold. When not editable, it is grayed out. It may be grayed out because you are not in edit mode or because your System Administrator has locked the field.

**Pick list**

For fields that contain a downward arrow like this ↓, click on the arrow to display the list of preset values from which to choose. You can also type the first letter of a value if known and it will jump to the first keyword that starts with that value. Typing the same letter again will scroll you to the next value that starts with that letter. For example in a State field, typing “i” will bring up “IA”, typing a “i” a second time will bring up “IL” and typing “i” a third time will bring up “IL”.

<table>
<thead>
<tr>
<th>State</th>
<th>County</th>
<th>Zip Code</th>
<th>Home Phone</th>
<th>Home Phone Message Type</th>
<th>Office Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>IL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IA</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ID</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GU</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HI</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IA</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Multi-value field**

There are some fields similar to the one shown below that allow multiple values to be selected. To check an item on the list, click on the item’s name and a check mark will appear to the left of the name. To remove a check mark, click on the name again.

<table>
<thead>
<tr>
<th>Other Languages Proficient In</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>American Sign</td>
<td>[ ]</td>
</tr>
<tr>
<td>Cantonese</td>
<td>[ ]</td>
</tr>
<tr>
<td>English</td>
<td>[ ]</td>
</tr>
<tr>
<td>German</td>
<td>[ ]</td>
</tr>
</tbody>
</table>

**Required Fields**

A red asterisk (*) next to any field signifies that the field is required by Provide® Enterprise in order to save the document. Some required fields already have a default value while others are blank by default.

**Date Fields**

When you see a date field in Provide® Enterprise you can accept the default value, hit the delete or backspace key to remove the current date and type in a different date, or click on the button which will bring up a calendar window shown below.

- Click on the day you wish to select. To move backward or forward a month at a time, use the appropriate button.
- You can also change the month by clicking on the name of the current month. This will bring up a list of months. Simply select the month that you wish to navigate to.
- You can change the year that is shown by clicking in the year (on the calendar) and using the up and down arrows (circled in the following figure) to change the year.

**Radio Button**

An example of a radio button (○) is shown below:
A radio button will allow you to select one or more choices. Simply click on the radio button (○) that corresponds to the choice or choices you wish to select.

**Check Box**
Some fields in the system have check box fields. To check an item, click on the box to select it.

**Field Dialog Control Button**
Some fields have lists from which to choose a value. Most of these fields will have a ▼ button to click that will activate the list. To select an item in the list, click on the item name. To deselect an item, click on the item name again. Provider fields, Diagnosis fields, Procedure fields, Drug name fields and Test name fields are examples where Field Dialog Control Buttons are used. In some cases you are able to select only a single value and in others you are able to select multiple values. Both types will be discussed below.

Click on the ▼ to expand the options under each category and click on the ▼ to collapse the options under each category.

**Provider Field Single Value**
There are many fields within Provide® Enterprise where you can select a Facility, Individual, Medical Group, Service Organization, Service Program or manually enter a value. You will be able to view your available provider options when you click on the ▼ button as the following shows.
**Provider Type:** The choices available for this field are set by your System Administrator in the data dictionary field properties of Provide Enterprise.

**Select:** By default, this field is set to Common and will display a list of common providers that you have defined in your user preferences. If you have not defined any common providers, the “Provider Name” view will be blank. You may also choose to change this setting to “All” to display all providers that have been defined in Provide Enterprise.

**Search:** You may manually type a provider name such as “Smith” in the search field and then click on the “Search” button. All of the provider names with the first name or last name of “Smith” will appear. When searching for a word or phrase you can use an asterisk (*) as a wild card.

If used at the end of the string like Smith*, it will find all values that start with “Smith”. If used at the front like *Smith, it will find all entries that contain “smith” anywhere in the string. You can also use a wild card in the middle like s*h to pull values like “smith” or “seth”. You can also search the entire database or just the subset of displayed results.

**Provider Field Multi-value**

There are places within Provide Enterprise where you can select more than one Facility, Individual, Medical Group, Service Organization, and Service Program or manually enter a value. You will be able to view your available provider options when you click on the button as the following shows.

**Provider Type:** The choices available for this field are set by your System Administrator in the data dictionary field properties of Provide Enterprise. Generally you will have the ability to choose from a Facility, Individual, Medical Group, Service Organization or Service Program. Both the “Provider Type” and the “Select” group that is chosen will limit your choices in the “Provider Name” view.

**Select:** By default, this field is set to Common and will display a list of common providers that you have defined in your user preferences. If you have not defined any, the “Provider Name” view will be blank. You may also choose to change this setting to “All” to display all providers that have been defined in Provide Enterprise.
**Search:** You may manually type a provider name such as “Smith” in the search field and then click on the “Search” button. All of the provider names with the first name or last name of “Smith” will appear. When searching for a word or phrase you can use an asterisk (*) as a wild card.

If used at the end of the string like smith*, it will find all values that start with “smith”. If used at the front like *smith, it will find all entries that contain “smith” anywhere in the string. You can also use a wild card in the middle like s*h to pull values like “smith” or “seth”. You can also search the entire database or just the subset of displayed results.

**Add Button:** Whether adding just one provider or adding multiple providers to your Selected Items list you need to place a check mark to the left of their name as shown in the figure below.

**Button Bar**
There are many places in Provide® Enterprise where you will notice a series of buttons arranged at the top of records and views. Below is an example of a button bar from the Client Profile record:

![Button Bar Example](image)

The kinds of buttons will vary from record to record. Some of the more common buttons are described in detail below.

**Print**
The “Print” button will allow you to print data from the open record to a Crystal Report template. The output can be set to either display on screen in order to review before printing or it can be automatically sent to the user’s default printer. You can select what you would like to print by clicking on the down arrow and selecting your printing choice.

![Print Buttons](image)

**Edit**
The **Edit** button places the record you are viewing into “edit mode.” Once in “edit mode” you will be able to change field values and select items from drop down lists.

**Action**
The **Action** button allows you to select from a list of available actions. These actions differ depending on what you are doing in the Client file.
Create
Clicking on the button will show you a pull-down list of all Activity Record types you are able to create.

Document History
Every time changes are saved to a record in Provide® Enterprise, an updated version of the record is created. The buttons allow you to view previous versions of the record you have open in order to see what the record looked like at a particular point in time. You can either pick a date from the drop-down list or move backwards one change at a time by clicking the “left arrow”.

When viewing a previous version of the record you will notice that “Historic View as of ...” will be displayed at the top of the record.

Fields that are highlighted in yellow are fields that are different from the most recent version of the record. You are not allowed to edit a Historic View of the record. To edit the record after referencing a Historic View you will need to switch to the Current view as shown below:

Delete
Provide® Enterprise allows you to delete any Client Sub-Records and Activity Records. Only the creator of the original document or their supervisor can delete the document. When a document is deleted it is not truly deleted from the database. It will remain a permanent part of the client record, but will be
“marked” as deleted (similar to putting a line through an incorrect entry in a paper record) and thus, will not be counted in reports. To delete a record, follow these steps:

- Open the Record in question.
- On the Action Bar, you will see the **Delete** button. Clicking on this button will open this dialog box:

![Delete Dialog Box](image)

- Select the reason you are deleting the chart note and then click on the **OK** button. You will be backed out of the note.
- Any time the record is opened in the future, you will see a message similar to that in the following figure at the top of the record:

![Deleted Record Message](image)

- In bold and highlighted a light yellow, it will state who deleted the records and the date and time the record was deleted.

**Un-Delete**

Once a record has been marked as deleted, you have the ability to “un-delete” the record within Provide® Enterprise. Only the creators of the record, their supervisor or System Administrator can “un-delete” a record. To “Un-Delete” a record, follow the steps below:

- Navigate to the particular record in question and open the record. Because the record has been marked as deleted, you will see the **Un-Delete** button.

- Click on this button to “Un-Delete” the record. The deletion information will be removed, the record will be re-saved and you will be closed out of the record. You will notice after refreshing your screen that the Delete flag has now disappeared from the database views for this document.

**Saving Record Changes**

The “Close” button closes the current record you are viewing.

- If you have changed fields, you will usually be asked if you want to save the changes you have made as shown below.

![Save Changes Dialog Box](image)
• If you have made changes that you want to save, be sure to select “Yes”.

• You could also click on the “Details >>” button to see a list of all the changes that were made while you were in the record. A sample of what you might see is displayed below:

![Save Changes? dialog box](image)

• You can choose to save all of the changes that you made or you can delete changes that you do not want by clicking on them individually and hitting the delete key on your keyboard. If you double click on the change you will be taken to the Sub-tab that contains the field that you modified. You can also select “Cancel” to return to the document or “No” when prompted to save your changes, and the record you were in will close.

• Sometimes when you click on the “Close” button to save your changes you will see a box that looks like this:

![Save Changes? dialog box](image)

• This can happen because the Provide® Enterprise system does not “lock” records when they are opened by users, so two or more users could be editing the same record at the same time. Here is a scenario where this may occur. First, we assume that two users open the same Client Profile at the same time. One person may make changes to the “Ethnicity” and “Race - Primary Identified” fields in the Client Profile as shown in the example above, and that person saves their changes. A second user may change the “Ethnicity” field and “Citizenship” field, when the second user closes the Client Profile they see the following message:

![Save Changes? dialog box](image)

If they click on the “Details >>” button, they would see a screen similar to the one below:
The following rules apply to the “Details” display when two users make changes to the same record:

- The first user to save their changes will have the changes applied without any warning message.
- The second user to save their changes will see the warning “Note: Changes were applied to this document since you opened it. Do You Want to Save Changes?”
- If both users make changes to the same field, the second user will only see the original value of the field and the changes that they made. The “Changed By” box will be blank.
- If only the first user changed a field (See “Race - Primary Identified”), the second user will see both the original value and the new value of that field. The “Changed By” box will show the name of the user who made the change.
- The second user will always see every field they changed and the original value. The “Changed By” box will be blank.
- Any change that is deleted from the “Details” display will result in the original value that is shown in the “Old Value” field being saved.
- If the second user accepts all of the changes and clicks on the “Yes” button, they will update every field they changed and all unique changes that the first user made.
- If the second user selects “No” when prompted “Do You Want to Save Changes?”, only the first user’s changes will remain.

You can choose to save all of the changes that you or the other person made by clicking on the “Yes” button, or you can delete changes that you do not want by clicking on them individually and hitting the delete key on your keyboard. If you double click on the change, you will be taken to the Sub-tab that contains the field that you modified. You can also select “Cancel” to return to the document or “No” when prompted to save your changes, and the record you were in will close.

**NOTE:** You might also see the “Changes were applied to this document since you opened it” if you make changes to the Client Profile and then edit the Current address record. This happens because whenever you save changes to the “Current Address” record the Provide® Enterprise program automatically updates the fields in the Client Profile then as well. This is accomplished by saving a new version of the Client Profile with the same values as entered on the Current Address record.
**Save and Create Another**

The **Save and Create Another** Button is available in many of the Activity Records within Provide® Enterprise. When you see this button, you can use it to close and save the current document you are in and open a blank record of the same type.